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Document History
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Description
Release 6.11.4.5
Release 6.11.4.3
Release 6.11.3.3
Release 6.11.2
Release 6.11.1.1 Includes updates published July 23, 2013
Release 6.11.1
Release 6.11.0.1 Includes updates published July 23, 2013
Release 6.11
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Release 6.11.4.5
Contains Device Pack 1.0.21.4

Device Pack Fixed
Fixed
PACK-1833
PACK-1836

Erroneous dialog box with SurrogateExe.exe no longer displayed
Bosch: Correct FPS settings used and displayed

Symphony Fixed
Fixed
AIR-18565
AIR-24167
AIR-24169
AIR-24246
AIR-24271
AIR-24428
AIR-24689
AIR-24768
AIR-24769

Erroneous setting and message to delete Axis video encoder from farm resolved
Switching cameras in Web Client working correctly
Web Client login working correctly
Detailed Events correctly logging configuration change
Web Client alarm list correctly displays images
Switch views on alarm working correctly
Manage Security permissions working correctly based on user configuration
Panel switching of video wall successful
Client option setting Perform action after switch successfully disabled

Release 6.11.4.3
Contains Device Pack 1.0.21.0

New
New
AIR-14810

Importing devices with multiple streams via CSV file now supported

Improvements
Improvements
AIR-11562 Tools available include correct version numbers, including:
 VideoWallAlarmSwitchConfig
 AddDIORulesFromCSV
 SetActiveProfile
AIR-22266 Video decoration font improvements implemented
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Fixed
Fixed
AIR-13952
AIR-18339

Second stream video displaying correctly
You can now hide the mouse cursor on live video displaying on any video panel.
When this feature is enabled, the mouse cursor disappears after five (5) seconds
of mouse inactivity. The cursor reappears immediately when the mouse moves or
when an alarm popup appears in the system tray.
This feature is disabled by default. To enable the feature per server, edit
%appdata%\<ProductFolder>\acc.ini and change the following parameter as
needed:
[CameraVideoView]
CursorOffOnVideo=True

AIR-18878
AIR-19175
AIR-19707
AIR-22261
AIR-22265
AIR-22269
AIR-22271
AIR-22274
AIR-22280
AIR-22305
AIR-22320
AIR-22361
AIR-22368
AIR-22375
AIR-22399
AIR-22400
AIR-22401

Note: When an Alarm popup appears in the system tray, the cursor disappears
five (5) seconds later until another alarm is detected.
Creating a New Camera View from an existing camera group working correctly
Resizing a New Camera View displaying correctly
Device Tree Configuration Cancel option working correctly
Device List correctly populated following server upgrade
Server Farm List correctly populated following server upgrade
Alarm popup window active and working correctly following server upgrade
Server Configuration dialog Server field displays the hostname of the server
where the device is connected
Decoration color settings propagated throughout all servers in the server farm
correctly
Changing video decoration transparency working correctly
Disabled PTZ notifications include usernames which are visible only to users with
administrative privileges
Phoenix: Input mapping corrections implemented to prevent missing and
duplicate input triggers
SDK: Panel switching working correctly
When attempting to switch panels using the SDK to unregistered clients, a
notification error is displayed
Licensing working correctly in large multi-server farms where servers have
multiple MAC addresses and network interface controllers
Client no longer closing erroneously after managing Symphony services (Server >
Services > Manage Symphony Services)
Web Client: Server connection performance and logging enhancements
implemented
Video recording stops correctly when an alarm is triggered for a camera set to
never record with a post-event buffer; recording stops when the entire post5

Copyright © 2015 Aimetis Corp.

Fixed
AIR-22416
AIR-22417
AIR-22418
AIR-22422
AIR-22437

AIR-22438
AIR-22445
AIR-22973
AIR-22450
AIR-22453
AIR-22466
AIR-22469
AIR-22498
AIR-22796
AIR-22943
AIR-22972
AIR-22981
AIR-22985
AIR-23018
AIR-23019
AIR-23052
AIR-23062
AIR-22986
AIR-22987
AIR-22994
AIR-22998
AIR-23003
AIR-23005
AIR-23006

event buffer is complete
Videowall: Working correctly when loading new device model
Videowall: Mixed mode working correctly where server version is different than
client version
Speed improvements implemented when switching live video via direct
connection
When importing a PTZ camera as a fixed camera, editing the camera’s device
configuration overwrites the camera type correctly
Camera tree updating immediately following device model changes.
New devices added show with ID of 0 until the server updates with the correct
camera ID
Maps: Client connection status visible in Maps panel
Timeline: Purple circle indicating the current video panel position displaying
correctly
Restricted users can view live video when the database is unavailable
On slow networks or hardware, intermittent dropped video data and playback
issues resolved
Videowall: In a multi-server farm environment, concurrent panel switch
commands working correctly
When a connection is lost, or a camera moves to a different server, client
reconnects to historical video stream correctly
Moving digital I/O devices to another server signaled correctly via SNMP
Device model changes applied correctly when the Server Configuration dialog is
open
Multiple login deny user permission working correctly
Setup Wizard working correctly in silent mode
Viewing blank camera working correctly
Videowall: No longer logging erroneous errors when switching panels

Symphony Manager services working correctly for users with Administration
privileges
Web Client: Banning and unbanning video no longer causes camera tree display
issues
Help > Report an Issue > Upload to Aimetis option saves file to desktop correctly
Video export working correctly
Users Viewing Camera option refreshing correctly when logged in user changed
Videowall: Client interface no longer hanging when Videowall Manager launched
Web Client: Server popup messages display and refresh correctly showing a
maximum of 3 messages at any time
6
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Fixed
AIR-23007
AIR-23015
AIR-23016
AIR-23017
AIR-23021
AIR-23023
AIR-23036
AIR-23037

AIR-23055
AIR-23069
AIR-23072
AIR-23079
AIR-23089
AIR-23090
AIR-23095

AIR-23096
AIR-23989

Device Tree configuration Apply option no longer resulting in Client crash
Videowall: No longer logging erroneous “Failed to connect to videowall
controller” error during load balancing
Web Client: Timeline hidden after banning device
Videowall: Performance improvements implemented
Videowall: Decoration transparency settings pushed correctly to all viewers
Switch view when an alarm occurs functionality working correctly without
logging erroneous exceptions
Videowall: Changing panel video quality working correctly via Videowall Manager
Server Configuration > General Settings > Decoration Text Background color
preview displays the color name for Black and White and specific RGB values for
any other specified color
Note: Color preview does not include any configured Transparency value
Videowall: Clicking Refresh in Videowall Manager working correctly
Direct Connect devices displaying decorations correctly
Viewing camera activity (View > Activity for Cameras) and zooming in on images
working correctly
View Current Logins functionality (Server > View Logins > Current Logins) displays
computer hostnames only and not IP addresses
Modifications to Messenger message text size and position are correctly applied
and updated
Digital I/O rules import and export via CSV loading policies and rules correctly
Client lock Panel add/Panel close functionality working correctly
View > Settings > Lock > Panel adding/closing hides related menu buttons and
their associated View menu options
Client interface unlock functionality no longer displaying erroneous permission
error
Videowall: Video displaying on all panels correctly

Release 6.11.3.3
Contains Device Pack 1.0.14.0

New
New
AIR-16085

Auto-upgrade feature for Symphony client

Improvements
Improvements
7
Copyright © 2015 Aimetis Corp.

Improvements
AIR-19610 Device Pack update can be postponed successfully when importing cameras
through CSV file
AIR-19662 Improved performance
AIR-20027 Improved CPU performance and decreased memory impact
AIR-20193 Reduced memory usage when device model refreshes

Fixed
Fixed
AIR-19427
AIR-19520
AIR-19525
AIR-19528
AIR-19529
AIR-19535

AIR-19556
AIR-19593
AIR-19594
AIR-19596
AIR-19598
AIR-19602
AIR-19603
AIR-19604
AIR-19606
AIR-19607
AIR-19608
AIR-19611
AIR-19612
AIR-19620
AIR-19623
AIR-19625
AIR-19627
AIR-19628
AIR-19631
AIR-19633
AIR-19637

Web Client: Functions correctly and no longer displaying “Error getting remote
version”
Symphony ensures disk cleaned before reaching full capacity
Infoservice continues working successfully after PollForChanges
User can successfully view historical images for a specific time
Farm name and logged in username correctly displayed in title bar
Web Client: Changing camera views working correctly and no longer sending
PageRequestManagerParserErrorException or “Error communicating with server”
warning
Digital input states correctly updated in Camera Tree
Setup Wizard correctly times out in case where server is not responding
Trackers correctly start with different server versions after swap while upgrading
Mixed mode, videowall switching successful
Cameras can be moved successfully without server license issue
Client works correctly with Alarm Log showing 1000+ alarms
Focus on selected camera in Camera Tree maintained correctly after Camera
Tree refresh
SDK application: Resume Record Mode working correctly in live stream sample
Client CPU usage impact reduced sufficiently when large Camera Tree set to auto
expand
Client sessions working correctly and no longer registering InvalidSession error
SDK application: Invoking Can Change Panel Videowall correctly shows
permission error when invalid user entered
Editing user groups working correctly when device model changes
Server license correctly published on startup
Camera Tour: User successfully able to add first preset location
Active user profile access working correctly
Database connection working correctly with no lost frames
Client runs successfully after interaction with Maps
16-panel multi-view closes successfully in expected time
Web Client: Runs successfully when InfoService down or not responding
Client auto upgrade successful
Request User Credentials working correctly
8
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Fixed
AIR-19642
AIR-19644
AIR-19646
AIR-19648
AIR-19649
AIR-19671
AIR-19673
AIR-19678
AIR-19686
AIR-19687
AIR-19692
AIR-19696
AIR-19697
AIR-19704
AIR-19705
AIR-19706
AIR-19708
AIR-19710
AIR-20896
AIR-19716
AIR-19717
AIR-19722
AIR-19723
AIR-19727
AIR-19728
AIR-19729
AIR-19736
AIR-19740
AIR-19745
AIR-19748
AIR-19749
AIR-19759
AIR-19894
AIR-19901
AIR-19905
AIR-19953
AIR-19959
AIR-19966

Users viewing camera correctly displayed in Map context menu
Users viewing camera feature correctly displays only users with live view
Videowall: Connection intact when creating 9 panel or larger multi-view
Videowall: Can successfully modify panel settings
Text displayed correctly in German
Tracker no longer producing Algolist.txt files. Following an upgrade, users can
delete *agolist.txt from the Symphony data path to remove remaining legacy files
InfoService memory leak resolved
Server Registration with SSO working correctly
Client auto-upgrade installation reruns automatically if Error Code 1618 reported
Client device model updates working correctly
Client auto-upgrade retains previous settings and configuration correctly
Web Client: Working correctly following server farm redirect
Users viewing Cameras displays correct information
Recording schedule changes saving correctly
Videowall: Layouts list sorted alphabetically
Device Tree Configuration: Can successfully add groups as administrator
Client initializing correctly
Device name changes correctly
Clicking on an alarm successfully selects it
Poll rate changes saving correctly
View Detailed Events works as expected
PTZ Locked: Video decorations update correctly
PTZ Locked: Properties unlock correctly
PTZ Navigation buttons consistently notify user when control attempts are
unsuccessful
Client interface remains visible while editing user groups
Alarm Log in advanced mode no longer causes a crash
Device Tree Editor loads successfully
Videowall SDK: Can view blank camera successfully in SymphonyFarmTest sample
Web Client: Timeline interface displays as expected
Camera Tree: Manually entered device states reflected correctly
Camera Tour: Location added successfully
PTZ Indefinite Lock functions as expected
MessageDispatcher recovers successfully if no dispatchers available
Videowall panel switching works correctly, and better error reporting has been
added.
Camera Tour: Deleting a tour works correctly
Camera Tour: Adding another tour works correctly
9
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Fixed
AIR-19994
AIR-20051
AIR-20095
AIR-20096
AIR-20098
AIR-20100
AIR-20148
AIR-20184
AIR-20194
AIR-20195
AIR-20196
AIR-20221
AIR-20224
AIR-20247
AIR-20253
AIR-20190
AIR-20233
AIR-20237
AIR-20256
AIR-20259
AIR-20263
AIR-20269
AIR-20277
AIR-20281
AIR-20284
AIR-20299
AIR-20304
AIR-20308
AIR-20343
AIR-20346
AIR-20350
AIR-20351
AIR-20363
AIR-20364
AIR-20366
AIR-20408
AIR-20417
AIR-20425

Xnet password no longer visible or logged
Videowall showing video correctly
Clients initializing correctly on startup
Client initialization delay resolved
Improved performance for trackers showing video
MJPEG cameras showing correct colors in images
Diagnostic Stats logging frequency changed from every four (4) seconds to once
every five (5) minutes
Improvements made to diagnostic error logging

Videowall: Error handling is improved is constantly crashing on the Videowall
Symphony Clients function correctly following a server farm upgrade
Johnson Controls: Device Discovery working correctly
Switching to 'Blank camera' works correctly
Event logs are captured successfully except during system archive.
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10278
Improvements made to server farm communications and error handling
Changing cameras works correctly
Images exported to a file or to the Windows Clipboard render with correct colors
Client authorization intact after switching security profile
Modifying Symphony Rules works correctly
Reason field correctly functioning as optional for Supervisor login after changing
settings
Timeline in sync displaying JPG images
Web Client: Displays video correctly when prompting for install plugin
Client working correctly after importing devices
Improved performance moving multiple cameras between systems
Improved error handling and messages when hardware devices not found
Device Manager: Refresh working correctly
Client working correctly after switching cameras
Camera name and frame statistics correctly display on video
Client working correctly when trying to unlock PTZ during tracker restart or stop
PTZ locking working correctly
Symphony Client successfully saves device changes to an available server when
the original server is unavailable
You can successfully configure PTZ on Q7406 encoder after an upgrade
10
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Fixed
AIR-20429
AIR-20430
AIR-20431
AIR-20434
AIR-20435
AIR-20438
AIR-20440
AIR-20441
AIR-20443
AIR-20446
AIR-20447
AIR-20448
AIR-20450
AIR-20452
AIR-20455
AIR-20456
AIR-20457
AIR-20458
AIR-20461
AIR-20464
AIR-20465
AIR-20466
AIR-20467
AIR-20468
AIR-20469
AIR-20470
AIR-20481
AIR-20568
AIR-20600
AIR-20606
AIR-20626
AIR-20654
AIR-20669
AIR-20692
AIR-20754

Web Client: Load balancing correctly
Large camera import correctly includes all cameras
License updated correctly after adding camera
Direct-mode camera correctly displays access denied message when live video is
denied or banned
Devices are correctly managed during a server failover
Alarms are no longer visible in the Client, Alarm Logs, and via alarm popups for
cameras with banned video
Camera imports work correctly
Changes to device groups are saved and displayed correctly across multiple
Symphony Client instances
Active directory user resolution works correctly via Single Sign-On
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10279
System messages correctly displayed when client restarted
PTZ lock priority messages improved
Setup Wizard works correctly during InfoService interruptions
Client continuous working correctly when loading Device Tree
Clients working correctly following Videowall Manager modifications and refresh
Client no longer displaying erroneous pop-up message “Attempt to release mutex
that was not owned by caller”
Videowall Controller panels connecting correctly
Timeline working correctly for missed signals and disk full scenarios
Messaging improved when unauthorized users attempt to control PTZ cameras
Symphony database connection regained correctly following disconnection
Exporting cameras to CSV file works correctly
User changes are saved successfully
Device Pack: Installer warns you that it requires all Symphony services stopped
before installation begins
User Permissions dialog displays correctly
Backup configuration restore working correctly
Alarms working correctly regardless of database connectivity
Device model changes are pushed correctly to database on refresh
Camera import from CSV works correctly
PTZ Lock Message no longer erroneously displayed on client
Symphony installer prevents upgrade to an unlicensed version
PTZ camera logs captured correctly
Camera initialization working correctly
InfoService logging active user data correctly
Symphony Installation includes required 64-bit runtime files for 64-bit OS systems
Alarm Log scrolls to focused row when new alarm occurs
Database up/down state moved to Shared Memory
11
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Fixed
AIR-20783
AIR-20791
AIR-20794
AIR-20841
AIR-20844
AIR-20846
AIR-20862
AIR-20471
AIR-20873
AIR-20897
AIR-20898
AIR-20935
AIR-20936
AIR-20876
AIR-20890
AIR-20899
AIR-20905
AIR-20908
AIR-20915
AIR-20916
AIR-20933
AIR-21640

Alarm Logs working correctly
Direct Connect working correctly
Tracker works correctly showing video when database is down
VE180 configuration retained after upgrade
Discovering devices works correctly
Client working correctly during periods of high CPU usage
Rule Wizard working correctly
Videowall: Panel switching working correctly

Scheduler automatically restarts after Phoenix device goes offline
Rule Wizard: Schedule edits working correctly
Client software updates automatically
Switch view on alarm working correctly
PTZ Lock Message no longer erroneously displayed on client
Videowall: Camera switching working correctly
Web Client: Displaying Profile Switch messages correctly
The View Blank Camera option works correctly when viewing JPEGs
Axiom RBH Access Control working correctly

Release 6.11.2
Contains Device Pack 1.0.7.0

New
New
AIR-16085

Automatic upgrade feature for Symphony Client
Now includes Symphony Client upgrades in addition to Device Packs
See also KB Article: How to change download scheduling and speed for Device
Pack and Symphony Client updates

Improvements
Improvements
AIR-19232 Overload protection message now indicates which server has high CPU load
AIR-19253 Improved performance from decreased load on database
AIR-19254 Increased performance from reducing CPU load
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Fixed
Fixed
AIR-12630

AIR-15451
AIR-18475
AIR-18490

AIR-18746
AIR-18747
AIR-18750

Can use keyboard to select Windows Authentication check box in Symphony
Server Connection dialog box.

Setup Wizard Status Setup dialog box no longer showing erroneous “Failed to
notify the following servers” message
Phoenix input alarm rule action successfully moves PTZ camera to preset location
SNMP walk command successful when setting SNMP Retries to 2.
Instruction added to Symphony 6.12 Administration guide:
SNMP using UDP, set SNMP Retries to 2. (Using iReasoning MIB browser, for
example, Tools>Options>General tab, SNMP Retries=2 field.)
Manage Services and Devices access rights correctly enforced
Failover on multi-server farm: showing correct number of cameras on servers and
correct number of redundant servers
Importing large number of cameras successful

and

AIR-18751
AIR-18763
AIR-18768
and

AIR-19018
AIR-18837
AIR-18841
AIR-18844
AIR-18860
AIR-18861
AIR-18863

Client on one machine accurately updated when changes made to same client
running on another machine
Successfully export .aira and .avi from a standalone client. Video export from
Client working correctly when server and client in different time zones
Camera ID/code visible in video when using Direct Connect
Failover successful after power outage and hardware issues
Failover to correct servers after power and database outage
Moving numerous cameras to another server not issuing erroneous database
connection loss messages
New Carousel dialog box opens correctly
Camera Tree displayed correctly after ActiveX Plugin installed on machine with
Symphony Web Client
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Fixed
AIR-18866
AIR-18867
AIR-18868

View Logins dialog box loads successfully with over 500 concurrent users logged
in
Symphony Client runs successfully when opening more than 1000 cameras in
Activity For Cameras dialog box
Ban Video feature in Web Client correctly denying specific user access to camera

and

AIR-19197
AIR-18874

AIR-18877
AIR-18880
AIR-18883
AIR-18884
AIR-18885
AIR-18887
AIR-18895

AIR-18996
AIR-18902
AIR-18904
AIR-18916
AIR-19920
AIR-18951
AIR-18995
AIR-18958
AIR-18953
AIR-18963
AIR-19022
AIR-19023
AIR-19026
AIR-19030

Web Client on HTTPS: When redirecting requests, Symphony preserves HTTPS
protocol and HTTPS port.
Important: All servers in a multi-server farm must have SSL certificates installed.
If not, then you will receive an “Internet Explorer cannot display the webpage”
error. See also: How to Configure Symphony Web Servers for SSL (Windows 8)
Selecting an alarm in the Basic or Advanced Alarm log correctly shows the
matching image (JPEG) in the panel (camera view)
Delete All Searches, View Search Details, and Search speed improved and Delete
All Searches issue with non-responsive Symphony Client resolved
Correct status for PTZ lock/unlock displayed in PTZ Lock Properties dialog box
Hikvision cameras working correctly in Direct Connect mode
Muted audio on camera correctly remains muted upon Camera Tree refresh
View Detail Events on busy server farm loading correctly
User can now unlock PTZ using PTZ Lock Properties dialog box options after
initiating lock with PTZ Controls (lock icon) or red arrow method (right-click and
mouse move)
ExportDIORulesToCSV.exe too is successfully exporting rules to .csv files
Time decorations readable when using H264 480x360 on Mobile Android devices
Phoenix Device selected and saved with various Inputs and Outputs no longer
generating Exception errors in Log Files
CPU overload protection working correctly
Supervisor mode: permissions enforced correctly for editing supervisor account
Client correctly will NOT update with changes from other users (on other clients)
while Server Configuration or Camera Tree open
Memory use decreased
Moving camera to another server successful and correctly updates server field of
camera
Axis audio settings pushed and received properly
Database disconnection issue resolved. See also How to reduce deadlocks and
improve SQL server throughput and performance
Access Denied message correctly displayed for user with limited permissions
viewing camera using Direct Mode
German interface: space expanded for proper text display
PTZ Locked label on video correctly disappears after lock time expired
Historical JPEGs (images) correctly showing Decorations
14
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Fixed
AIR-19033
AIR-19073
AIR-19074
AIR-19106
AIR-19122
AIR-19129
AIR-19213
AIR-19214
AIR-19215
AIR-19246
AIR-19256
AIR-19298
AIR-19301
AIR-19425
AIR-19490
AIR-19505

Correct number of Users Viewing Camera tabulated in client using Direct Connect
during minimized and restored Multiviews
Videowall Manager successfully handling exceptions
No adverse effect with changes in Camera View Settings>Activity tab for
Videowall
Symphony correctly allows editing and saving active ports on I/O devices
User can successfully view live video in direct mode from camera on down server
PTZ Locked label correctly disappears when camera unlocked
Videowall correctly generates error messages when user tries to change a panel
with an incorrect panel name or when the Client is not running
Symphony correctly saves modified stream values for Pre and Post Event
Stream successfully deleted for a camera
View>Activity for Cameras time reference starts at midnight when dialog box
first open or for a selected date
Tracker synchronization process working correctly
License message correctly displayed in language setting of Symphony and OS
Videowall functioning correctly with Add Camera View feature
Exceptions in Rule Schedule saved correctly
Symphony functioning correctly when registering new videowall client in
videowall designer
Smooth video playback from Panasonic cameras with lower CPU usage

Known Issues
Known Issue
AIR-19484 Client-only installer does not install .NET Framework 3.5 on Windows 8
Workaround: Install .NET Framework 3.5. See http://www.microsoft.com/enca/download/details.aspx?id=21
AIR-19511 Installation fails with exit code 1603 on Windows 2003 r2 x32
See solution: https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10240

Release 6.11.1.1
Fixed
Fixed
AIR-18325
AIR-18345
AIR-18612
AIR-18843

Configuration backup process successful on large scale server farms
Panel settings (right-click on panel and select Settings) rendered correctly
InfoService correctly starts if database down
Failover working correctly
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Release 6.11.1
Contains DevicePack 1.0.5.0

New
New
AIR-17466

AIR-17688

ADD-ON Feature only
Aimetis Symphony alarms can be raised in response to intercom calls initiated
from devices within a Jacques 650 Intercom system.
This is an add-on feature only.

New Shadow Removal option in Environment tab of Multi-layer Hybrid
background of VE180: reduces the effect of shadows, while preserving the
foreground objects.
Previously only available as parameter in XML. See KB article for 6.11.0 release:
ShadowRemoval parameter for VE180 analytic engine

Improvements
Improvements
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Improvements
AIR-16034 SMTP Port Configuration for emailing. You can define which port to use for the
SMTP server. Note that you must select the SSL check box to work with Google
Gmail.
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Improvements
AIR-16128 Reports:
 The Generate Image option is valid and displayed only for Heat Map
reports.
 The Include Summary Information option is valid and displayed only for
Object Counts Across a Line reports.

AIR-16596

Symphony 6.11.1 installation now supported on Windows 8 and Windows 2012.
Previously: https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10204
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Improvements
AIR-17637 Customers can now customize report filenames
By default, the filename is configured as:
Report Name_Year_Month_Day_Minute_Seconds_Milliseconds

AIR-18056
AIR-18355
AIR-18375

Heat Map zones: user can now move both the horizontal and vertical edges on an
angle
Onscreen tracking path output for PT091 removed. Less distracting to user
viewing video from moving camera.
Extensive improvements to Videowall with significant reduction in CPU load
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Improvements
AIR-18507 New option to restrict users to login in only once per server farm
Server Configuration>General Settings, Limit concurrent connections option
changed to Do not allow more than one concurrent connection per user
Previously:

AIR-18554

New SDK command line program TimelineGetter.exe

AIR-18569

Batch file for updating database for resolving user permission issues OR
"rerunning setup wizard may solve this" message
Improved log retrieval for large server farms
New server setting to disable/enable Videowall snapshot auto update
See KB article: How to enable the automatic snapshot update in Videowall
Manager window in Symphony 6.11.1
Background model improvement for images from thermal cameras.
It gives equal importance to intensity differences across the whole range of
possible values.
New Thermal option in Environment tab of VE180 analytic for Multi-layer Hybrid
background model.
3rd party systems can be connected o Symphony Server via the Symphony SDK
and play video from any camera that Symphony supports inside their client

AIR-18611
AIR-18621

AIR-18632

AIR-18753
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Fixed
Fixed
AIR-12964
AIR-15030
AIR-16033
AIR-17217
AIR-18095
AIR-18343
AIR-18491
AIR-18532
AIR-18537

AIR-18541
AIR-18543
AIR-18567
AIR-18593
AIR018626
AIR-18641
AIR-18650

Managing rules with camera selections as sub-events working correctly
Activity column in Object Statistics Report now displayed to 4 decimal places
Reports: When configured for 24 hour clock setting, Reports correctly display 24
hour times
Reports – Sensitivity tab: Error no longer created when user mistakenly deletes
numeric value in minute, seconds, or milliseconds fields for Dwell Threshold
Alarms displayed correctly when live video disabled
Videowall with direct connect correctly showing video and blank panel correctly
showing blank after switch
Symphony enables health monitoring correctly
PTZ camera tours working correctly when using schedules and auto-tracking
AI Authentication service starts after upgrading to Symphony 6.11.1
Previously: AI Authentication service will not start after upgrading to Symphony
6.11.0.x
Double-clicking on device in Quick Find correctly displays video from camera
Vivotek FE817X (fisheye) cameras dewarp image correctly for ground and ceiling
mount mode, functioning like PTZ
WCF-NonHTTP-Activation is installed during upgrade process, resolving AI
Authentication service issue
Deleting layout and/or Multiview layout working properly in conjunction with
interface
DIO rule to alarm on all cameras for systems with over 1000 cameras no longer
overloading CPU and causing tracker to run out of memory
Live video successfully displayed on iOS devices
LPR upgrade now automatically manages version compatibility between Server
and ALPR during installation
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Release 6.11.0.1
Includes Device Pack 1.0.4

Fixed
Fixed
AIR-17270

View Detailed Events dialog box now shows Key=users for Supervisor Logon with
two users

AIR-18570
AIR-13284

Camera connection memory over-allocation issue resolved
Value in PTZ Lock minutes automatically correct when user enters invalid number
of minutes in PTZ Lock dialog box

AIR-13287

Deleted layouts correctly removed from Videowall manager
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Release 6.11
New
New
AIR-4869

AIR-6924
AIR-11376
AIR-11705

New user privileges for hearing audio from stream

Camera load balancing between servers (requires Professional license)
Videowall manager: user can save and restore layout, minimum window size is
now smaller, and user can drag and drop cameras to videowall from Maps
Saving video clip directly to server/NAS implemented as part of Video export
feature in Symphony 6.8
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New
AIR-12733
AIR-17312

Symphony now supports two-way audio (for Axis, Sony, and Vivotek cameras
only)

See also AIR-4869
Works with direct connect mode as well
24
Copyright © 2015 Aimetis Corp.

New
AIR-12959
AIR-15234

Symphony now supports Bosch Dinion camera I/O on Maps and in Camera Tree
Administrators can view which users are viewing a camera
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New
AIR-16617

New option to restrict users to login in only once per server farm
Server Configuration>General Settings, Limit concurrent connections option

When a Symphony Client (or Web Client) session is terminated by an
administrator, the client's farm connection changes to "Unauthorized" and a
Logon dialog box is displayed.
The user can log back in by providing valid credentials.

AIR-16629

Known Issue:
In this BETA version, this feature does not work with Symphony Active
Directory Integration/Single Sign-On. As such, this feature of One Login Per User
is not properly enforced when users login to Symphony using Windows
Authentication. The Current Logins feature fails to reliably detect current logins
when made through Windows Authentication.
Symphony now supports Hikvision DIO on Maps
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New
AIR-17029

New interface for VE180 Video Analytic

3D Accurate People Tracking Advanced Tab
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New
AIR-17029 2D Fast Object Tracking Advanced tab
(continued)
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New
AIR-17030

AIR-17107
AIR-17237
AIR-17349
AIR-6924

BETA: VE180 video analytic now supports a Face tracking mode

Multiple streaming improvement reduces server, client, mobile bridge server,
and video CPU usage and bandwidth
Symphony now supports Hikvision DS-2CD7254FWD-EIZ cameras
CPU overload protection setting
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New

AIR-17504
AIR-17688
AIR-18046
AIR-18062

Symphony now supports JCI cameras
New background model that reduces the effect of shadows
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10186
Symphony supports AES256 for Single Sign On within a single domain. See also
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198
Added support for Johnson Controls DVN5000 NVRs

Improvements
Improvements
AIR-12325 Device Pack installation and Client Updates
how to: https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10165
error messages:
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10162
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Improvements

AIR-13742

User can drag and drop results from Quick Find search into any camera panel

AIR-14046
AIR-15235

Administrator can see which user has PTZ camera locked
Symphony SDK enhanced. SDK user can view a list of panels and videowalls that a
particular user has permission to change
ImportDeviceGroups utility now provides user with a confirmation dialog box if
errors found in .csv file

AIR-15262
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Improvements

AIR-15303
AIR-15349

Symphony supports I/O from Samsung devices, including I/O on Map and Camera
Tree
New Override label beside camera indicates that Record Video in the camera
setting was changed by right-clicking in the Camera Tree to Stop Recording.
The Override label reminds the user to right-click and Resume Record mode
when necessary.
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Improvements

AIR-15995

Symphony now supports multicast on HikVision cameras
DS-2CD883F-E
DS-2CD853F-E
DS-2CD854FWD-E(W)
DS-2CD855F-E
DS-2CD864FWD-E
DS-2CD7283F-EZ
DS-2CD7254FWD-EZ
DS2CD7264FWD-EZ
DS-2CD754FWD-EZ
DS-2CD753F-EZ
DS-2CD754F-EZ
DS2CD783F-EZ
DS-2CD764FWD-EZ
DS-2DF1-57A
DS-2DF1-570A
DS-2DF1-583
DS-2DF1-5803
DS-2DF1-5833
DS-2CD7153-E
DS-2CD7164-E
DS-2CD7264
DS-2CD7254
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Improvements
AIR-15997 Schedule: You can now schedule rules, guard tour schedules, and camera
recording schedules to per minute settings.

AIR-16205

New sensitivity parameter for VE180 analytic engine
High sensitivity level setting helpful in cases where a person's clothing is merged
with the background and low sensitivity level setting helpful in cases with high
levels of shadows or background movement.
Note: This new ForegroundAppearanceSensitivity parameter is not the VE180
interface. Accessed only by editing the configuration XML.
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10176

AIR-16423

Upgrade installer now verifies installation types: Symphony Server, Symphony
Client, and Symphony Player.
For example, Symphony Server must be upgraded with the server installation,
Symphony Client with the client installation, and Symphony Player with the player
install. If wrong installation detected, the user is prompted with a message and
upgrade stops after the user clicks OK. The message box informs the user about
the product and type of installation currently running, and instructs the user to
run the correct upgrade.
Symphony allows auto tracking on most Bosch Autodome cameras

AIR-16884
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Improvements
AIR-16951 Symphony Rule Wizard allows you to alarm on loitering vehicles

AIR-17040
AIR-17044
AIR-17059
AIR-17072

AIR-17243
AIR-17409
AIR-17437

Live Video runs smoothly even when writing to slow devices such as USB stick,
NAS, or a busy disk
Symphony now supports Samsung SNB-5001/7001 and SNP-6200(H) cameras.
See http://www.aimetis.com/Support/supported-video-devices.aspx
Increased accuracy of VE180 people counting
Maximum threshold in VE180 Multi-Layer Hybrid background model can now
accept values up to 500 seconds.
Select VE180 ->Environment -> Multi-Layer Hybrid, Adaptation

Dwell time estimation improved in VE180 analytic engine
Symphony now supports Pelco D5118 TCP cameras
When adding Multiview window to monitor with console, Multiview correctly
appears on top of console in Videowall Manager
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Improvements
AIR-17458 Axis P5534-E camera pre-calibrated for auto-tracking
AIR-17524 LPR – License Plate Recognition white/black list reload. See Aimetis License Plate
Recognition: How to configure Symphony to allow a 3rd party system to update
the license plate list
AIR-17539 Axis P5522 camera and Axis P5500 series pre-calibrated for auto-tracking
AIR-17545 Symphony logs warning for PTZ auto-tracking if camera movement responses
delayed more than 1 second
AIR-17593 Improved performance in PT091 video analytic
AIR-17285
AIR-17596 Symphony restore configuration/data process warns user in case data is older or
newer than the user’s current version of the software
AIR-17385 PTZ mode available immediately when adding Oncam cameras in 6.11. User does
NOT need to adjust the acc.ini file
Notes:
You must enable panoramic technology for the Oncam camera:
 In the Server Configuration dialog box, click the Video tab. Select the
Enable panoramic technology check box. From the drop-down lists,
select the Oncam camera and a Position (wall, ceiling, ground).
You can select panoramic modes from the context menu of the panel for the
camera.
In Fisheye View mode dewarping is turned Off; in other modes it is On.
 Right-click on the panel displaying video (live or historical) from the
Oncam camera. Select Dewarp. All options are displayed.

AIR-17691

See also: https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10164
Symphony receiving video from Axis cameras correctly after Axis Media Parser
upgrade
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Improvements
AIR-17800 Windows Desktop Experience now automatically enabled on server platforms for
Windows 2008 R2 and later during Symphony installation
AIR-18046 Symphony supports AES256 for Single Sign On within a single domain. See also
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198
AIR-18048 Logs: sccp.txt log file (cpu and memory stats) now also contains Windows and
Symphony processes, total memory CPU consumed by Windows and Symphony
processes, and column headings for clarity
AIR-18049 CPU load reduced for Symphony using Messoa cameras
AIR-18055 Memory and Logging tabs functionality in Symphony Client Settings merged into
new Advanced tab. New option for enabling/disabling message to user in the
event of a Symphony Client crash
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Fixed
Fixed
AIR-7415
AIR-8847

AIR-9457
AIR-9642,
AIR-14132,
AIR-14640
AIR-9840
AIR-10857
AIR-11079

AIR-11698
AIR-11720
AIR-12016
AIR-12229
AIR-12451
AIR-12458
AIR-13049
AIR-13051

AIR-13597

Symphony now supports Pelco Endura Spectra III EVS cameras
Heat Map Report: Tabular data now sorted by date and then time columns
(ascending). This applies to both exported tables and exported scheduled heat
map reports
Camera Tree updated correctly on Symphony client after deleting many groups
from Camera Tree
Cameras in Camera Tree show correct status of On when recording and Off when
not recording
Carousel window description correctly displayed as Carousel [Carousel Name] Server Name - Camera ID#) Camera name
When clicking on alarm in the Alarm Log, the Map panel correctly displays the
map associated with the camera alarm
Numerous fixes to display and layout of text in German language interface
(AIR-11115, AIR-11116, AIR-11119, AIR-11078, AIR-11081, AIR-11088, AIR11106, AIR-11108, AIR-11133, AIR-11122, AIR-11124, AIR-11125, AIR-11126,
AIR-11133, AIR-11134, AIR-11135, AIR-11137, AIR-12928, AIR-12942, AIR12945, AIR-12921, AIR-12946, AIR-13715, AIR-18251, AIR-11563)
Converting .aira files to MPG4 successful and play smoothing in Windows Media
Player
Hikvision camera resolutions displayed properly
Videowall with video from Bosch Dinion cameras refreshes images correctly with
no anomalies
Device import maintains correct licenses in Symphony
Floating Multiview loads correctly after saving
PTZInfo data handled correctly in import/export of .csv device list
User can load 1000+ maps without encountering unhandled exception errors
Maps - sorted alphabetically and “New Map” name is displayed with original
filename.
 When adding a new map, the Edit Maps dialog box focuses on the new
map in the list.
 When searching for a map in the main view search field of Maps, partial
matches are displayed based on the text entered in the search field.
SNMP Enabled setting changes in Server Configuration will take effect within 5
minutes on each server
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Fixed
AIR-14080,
AIR-17141,
AIR-17206,
AIR-17397

AIR-14082
AIR-14094
AIR-14367
AIR-14453
AIR-14505
AIR-14571
AIR-14606
AIR-15081

AIR-15229

AIR-15232
AIR-15254
AIR-15270

New columns added to CSV import/export options for device list.
Support RTSP streams in CSV camera import/export (Improvement)
Record Schedule ID
Record Schedule ID Stream2
Record Schedule ID Stream3
Record Schedule ID Stream4
Rotate Degrees
Resolution Stream2, 3, 4
RecordFPS Stream2, 3, 4
VideoFormat Stream2, 3, 4
RecordVideo Stream2, 3, 4
VideoQuality Stream2, 3, 4
KeyframeInterval Stream2, 3, 4
PreEvent Stream2, 3, 4
PostEvent Stream2, 3, 4
Audio Output
See the entire list:
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10123
Live video displayed correctly in Symphony Web Client when live camera moved
or swapped to another server
Client connections remain stable during database outage and when reestablishing
connection
Improved integration of Basler BIP2 series devices
SNMP is recording correct duration for web client login
Access successful after registering/unregistering videowall client
Editable Pre Event and Post Event fields correctly displayed when Record video
in Schedule or Schedule and Motion Detected by PC modes
.aira files converted successfully with Aira2Mp4
Correct context menu options displayed for user with denied access to Manage
Recording for all devices in Camera Tree for individual cameras and camera
groups
Multiple panels set to switch on alarm functioning correctly: only one panel
switches to the alarm camera. If multiple (different) alarms in succession, a
different panel is switched (if within 8 seconds)
New SNMP traps supported by Symphony: Health monitor fault detected, Health
monitor corrective action
Bosch Autodome 700 auto-detection, HD Live video, Record and Playback
working correctly
Bosch Autodome 800 auto-detection, HD Live video, Record and Playback
working correctly
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Fixed
AIR-15292

Aira2Mpeg speed parameter usage clarified and compared with Aira2Mp4
For Air2Mpeg [speed] is: 2.0 -> 50% speed, 1.0 --> normal, 0.5 --> 2x video speed.
For Aira2Mp4 [speed] is: 2.0 -> 2x video speed, 1.0 --> normal, 0.5 --> 50% speed.
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10178

AIR-15302
AIR-15429
AIR-17039
AIR-15438
AIR-15495
AIR-15561
AIR-15566
AIR-15575

6.7 or later Client connects successfully to 6.6.x or earlier Server
On-camera storage: Video downloads correctly for short interruptions
General improvements
HTTPS encrypted connection changes for Web Client. See KB article
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10169
New Aira2Mp4 tool does not require any codecs to be registered on the user's
machine. Use instead of Aira2Mpeg when converting AIRA files.
Correct time stamp and Alarm Log details time data for the alarms before and
after the DST transition
Symphony Export Video feature handles DST (from summer to winter time
change)
DIO working correctly if server at 5000 and 5001
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Fixed
AIR-15604

User can select narrower time frame for Event Data in Help>View Detailed
Events dialog box.

If threshold exceeded, user is warned with message and option to download
more.

User can also set threshold for event data in the Manual Configuration Editor.
See KB https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10177
AIR-15787
AIR-15817
AIR-15959
AIR-15971
AIR-15983
AIR-15986
AIR-16031

AIR-16073
AIR-16075
AIR-16124
AIR-16145

DIO reliable on Maps when using a high number of maps. For example, user can
add DIO input and outputs to Symphony server that contains 1000 maps
Carousel can be properly docked in main console
PTZ tour locations working correctly in Multiview (Camera view)
User with Export Video and Convert searches to other formats permission can
correctly convert search result in MPGEG format
Console layout rendered correctly when docking two carousels and opening
Application Log
Carousel displayed in the full screen correctly
Workaround for Timeline fills entire console
Changing regional settings in Windows Control Panel to German may cause
Timeline to fill entire console. Issue cannot be reproduced, but if encountered,
you must manually load a layout and the Timeline will be the correct size
Samsung SNP-3371 and SNP-3120 PTZ accurately controlled with mouse
Taskbar correctly appearing in background
Custom browser page displayed on Client start-up
User Configuration correctly accessible by Admin user after security profile
switches
41

Copyright © 2015 Aimetis Corp.

Fixed
AIR-16211
AIR-16372
AIR-16442
AIR-16464
AIR-16500
AIR-16522
AIR-16537
AIR-16546
AIR-16548
AIR-16624
AIR-16636
AIR-16653
AIR-16666
AIR-16716
AIR-16819
AIR-16823
AIR-16892

AIR-16894
AIR-16963
AIR-17043
AIR-16964
AIR-17031
AIR-17062

Camera configuration: DetectionXML set and updated correctly, and retains valid
data when modifying existing camera with invalid IP
Resolved floating Multiview issue of white gap appearing between top panels and
window
Highlighted zoom functioning as designed
Person reference icons in VE180 video analytic camera setup view formed
correctly when Distance field changed
Phoenix alarms received even when database down
Toolbar (navigation, timeline, decoration buttons) enabled if Client interface
locked
VE180 with dwell time is now white text on black background
For Admin group, for all security profiles, permission added as Allow
Window size of docked Multiview (camera view) retained when Client locked
Pelco 4001 encoder integration resolved
Symphony working correctly with 2MP mode in Samsung SND- and SNV-7080
cameras
Docked Multiview panels scaling correctly when loading Multiview
Symphony no longer supports Genetec Omnicast
Bosch Autodome 800 pans, tilts, zooms correctly in Symphony
Full alarm information included in alarm email in Chinese version of Symphony
Samsung cameras that support streaming over UDP displaying correct video
streams
Clearer message provided to users of ALPR that they cannot delete detected
license plate entries detected within the last 100 days – as designed.
Also see KB article: Error Message: One or more plates could not be deleted
Symphony detecting Axis P334X cameras correctly as fixed
Heat Map Report successfully created on non-English operating systems
Reports: Line graph correctly shows time intervals when only one camera
selected
Maps with many camera icons load rapidly
Symphony supports audio input on Vivotek cameras
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Fixed
AIR-17160

AIR-17162
AIR-17165
AIR-17218
AIR-17234
AIR-17241
AIR-17289
AIR-17290
AIR-17302
AIR-17335

AIR-17363
AIR-17521
AIR-17548
AIR-17557
AIR-17558
AIR-17588
AIR-17618
AIR-17656
AIR-17744
AIR-17766

Email notification option in Notifications screen of Server Configuration dialog
box changed for clarity to Video or Search deleted from “Footage/video deleted”

Multi-view (Camera View) renders correctly when changing to full screen
Decorations line up correctly on high and low resolutions
Devices do not move to different server when database services stopped or
database rebooted
Improved accuracy of people counting
In PDF format, Heat Map Report all columns correctly appear on one page
Symphony displays correct map when camera switched
Can import a CSV list that was exported from a 6.10 server
PTZ Camera triggered to record on motion correct records and stops
Alarm marking message "For performance reasons, you can only mark 50 alarms
at a time" is correctly displayed only once when more than 50 alarms are selected
for marking as real.
InfoService User Account correctly updated during upgrade
Map icons for camera, link, I/O device, or rule can be deleted successfully in Edit
mode
Symphony Player able to play a video (with known missing frames) in its entirety
Default tour name in Chinese for Chinese version working correctly
Distributed heat map reports sent successfully
Aira2Mpeg.exe now exporting faster video clips
Axis 232D and 211A PTZ camera no longer loses connection when alarm with
Auto-tracking triggered
Symphony now supports auto-tracking for Axis P5512 camera
FTP tab in Rule Wizard – Resize the transferred file setting reducing alarm
images correctly
When selecting 2 streams with the same resolution, Highest resolution option
uses the stream with highest FPS and Lowest resolution uses stream with lowest
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Fixed
AIR-17773
AIR-17788
AIR-17825

AIR-17833
AIR-17867
AIR-17869
AIR-17881
AIR-17887
AIR-17892
AIR-18130
AIR-17917
AIR-17919

AIR-17936
AIR-18004
AIR-18038
AIR-18088
AIR-18102
AIR-18126
AIR-18128

AIR-18129
AIR-18131
AIR-18135
AIR-18136
AIR-18137
AIR-18141
AIR-18156

FPS
User can easily create and delete fence line for VE150 in Rule Wizard
PTZ control no longer generating database errors in log
Resolution issues in some cameras, including Eneo PX Thermal cameras, have
been corrected with user adjustments necessary in Client and Server. For
instructions, see KB article:
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10172
Live and historical video streams correct for ACTi D11 and E11 cameras
Handle leak on Panasonic camera resolved
Zoom speed when using Joystick for PTZ camera reaching correct maximum value
User can set language for SMTP Messages
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10185
Setting Default max storage days to 0 in Server Configuration, Storage dialog has
no impact on Scheduler
Report emailing working reliably
Continuous Alarm option functions as designed
All users (including non-admin users) can view/modify their user information in
the Server>User Configuration dialog box.
Farm registration is automatically updated if credentials are changed through the
User Configuration dialog box on the local machine
OPC alarms working correctly
Messoa camera correctly displays video when database change camera settings
option disabled
PTZ control through interface and joystick functioning correctly for Panasonic PTZ
cameras
Socket handle leak fixed and logging improved
DDK cameras correctly receiving live video
Failover working correctly and stable database connection
Report columns correctly hidden when running a scheduled report
Note: If user wants to include summary information with a report (Distribution
tab), and user has hidden one of the columns used as a summary key, then the
summary information for that column will not be included in the report. Applies
to emailed and file saved reports as used by the distribution option.
Report storage location correctly updated if user modifies storage path location
Heat Map report displays zone labels correctly
Playback functioning correctly on Axis cameras recording 2 streams
Axis camera functions correctly when change frame rate on alarm option used
Reports list refreshed before batch run of scheduled reports ensuring that
deleted reports not included
ALPR: Issue causing error “Cannot start; required Dlls are missing” resolved
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Fixed
AIR-18146
AIR-18164
AIR-18196
AIR-18260
AIR-18271
AIR-18283
AIR-18362

Axis P3344 cameras detected correctly as Fixed
Scale correctly displayed in Heat Map image
Alarm Picture correctly attached to emails for alarms triggered on motion
Symphony Search feature working correctly. See error message information in
Error Message: Search is unable to complete knowledge base article
Visual C++ errors averted as Vivotek camera loads correct device dlls
Symphony protected from SQL injection and SetDocument path override
VMD or I/O event raising alarms correctly

AIR-18431

Audio from Axis cameras received in Symphony Client
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Known Issues
Sound
AIR-16867

Release 6.9.5,
6.10

Playing audio files via Rules does not work when using Server 2008
R2/Windows 7/Windows Vista
Workaround:

1. Download “psexec” online
(http://technet.microsoft.com/en-us/sysinternals/bb897553.aspx)

2. Setup AI Scheduler service to login as a user that has
previously logged into the server interactively.
3. Setup the computer to automatically log in on bootup as
the same user that is logging in AI Scheduler.
4. Create a playsound.bat batch file (all one line):
psexec.exe -i 1
f:\branches\trunk3\aira\_bin\schedulerplayer.exe play 1 0
c:\windows\media\chimes.wav
psexec.exe –i <session to run program in> <path to
schedulerplayer.exe> play <number of times to play> <delay>
<path to audio file to play>
5. The key “–i 1” must specify the interactive session number
for the process to run in.
a. To get a session number, run procexp.exe and turn
on the session# column.
b. Look at the session number for a process running
as the logged in user. This is probably always 1 on a
Windows installation with a logged in session;
therefore “-i 1” should always work.
6. Create a rule action similar to the following:
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Cardax Integration
AIR-16857

Release 6.10

User must repair OPC Bridge Configuration Version 6 from Cardax after
Symphony upgrade
Installing OPC Bridge Component 6.1.0.5 and the OPC Core Components
Redistributable software pieces are required for Cardax Access Control.
The OPC Bridge Component stops working after a Symphony server
upgrade.
Workaround:
If you have OPC Bridge Configuration Version 6 from Cardax installed
you must repair it after upgrading Symphony by re-running the OPC
Bridge Configuration installer.

Camera
AIR-12315
Release 6.5
Renumbered
as PACK-254

AIR-12896

Release 6.6

AIR-15613

Release 6.9

Support latest Mobotix Firmware for VMD of camera
VMD from Mobotix cameras is working only on devices running Fw.
3.4.09 (from 2008). With the Fw. 3.5 and 4.x (running on all new
models like M24, D24, Q24) it is not possible to use this functionality.
When adding Axis 241Q, only the first channel has default codec set
Camera
When adding Axis 241Q and other multi- channel video servers, such
as Hikvision 6104), and clicking the Connect to Camera button, only
the first channel has the default codec settings. All others channels
have a blank codec.
Will not fix.
Multi-lens cameras require one license
If you select a multi-lens camera, multiple licenses will be required.
You must contact Sales to be given the difference of licenses, for free.
This problem is typically only with Arecont cameras.

Interface
AIR-12409
Release 6.5
Renumbered
as PACK-175

Vivotek FD8361 crops image in stream 2 and displays stream 1
when navigating away from camera
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LPR
AIR-17540

Release 6.10.1

When LPR installer prompts user with message regarding gxsd.dat file,
user should select No.
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